
It’s All Right Here 
When you consider the wealth of 
capabilities and immense business 
value the MCP operating environment 
brings to EAE and AB Suite, one fact 
quickly becomes clear: there’s no 
better place for these solutions  
to reside.

Engineering Corner: Unleashing the 
Power of the AB Suite 6.1 Code Editor 
With the enhancements added to the 
AB Suite Code Editor, you’ll be able to 
make writing code an easy, intuitive, 
efficient process.

AB Suite Application  
Performance Tuning
We’ve developed a few clear steps 
you can follow should your AB Suite 
applications experience performance 
problems.  

EAE, TFS, and AB Suite: An Upgrade 
Success Story
We recently helped an EAE client 
update its source control environment 
and execute a smooth upgrade to  
AB Suite.

Info Center  
We provide a wide array of materials to 
help you stay up to date on everything 
that’s happening in the world of EAE 
and AB Suite.
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The world is moving fast.

Things move so quickly, in fact, that we 
rarely have time to simply stop and think. 
But pausing for a moment or two can be 
important: it gives us an opportunity to take 

stock, to consider the choices we’ve made and the value 
we’re getting from these decisions.

And when you’re running Enterprise Application Environment 
(EAE) on the ClearPath® MCP operating environment, pausing 
and taking stock means considering just how rock-solid the 
investment you have in place truly is. From performance 
and reliability to security and simplicity, the MCP operating 
environment delivers a suite of attributes you simply won’t 
find elsewhere.

As with nearly everything today, performance is king. And 
with EAE on MCP, you know you’re getting the high-volume 
transaction processing you need to help the business meet 
rising internal and external demands. You can even tap into 
extra power as needed, making it possible to address sudden 
spikes with ease. 

Because the MCP environment supports so many applications 
at once – and can update from release to release rapidly – 
you’re able to limit downtime and avoid the negative impact it 
has on your business. 

Plus, with the Enterprise Database Server for ClearPath MCP 
(DMSII) database, you know you’re protecting the integrity of 
the data your applications access and transmit every day.  >> 
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With high levels of resiliency, the ability to audit 
transactions, revert changes if needed, and store 
data using less space, the DMSII database is 
enterprise-class in every sense of the term.

And of course, security remains a paramount 
concern. But with EAE on MCP, you’re running a 
highly secure operating environment with no record 
of user data breaches, giving you the confidence  
to expand your application portfolio and take on 
more workloads while limiting risk.

Pulling this all together is the support you receive 
from Unisys. No matter if you experience an 
issue in the operating environment, development 
software, or hardware it all resides on, you know 
we’ll be there to help you identify and fix the 
problem – without resorting to workarounds  
or promising to address it in a later release.

This wealth of capabilities – and many, many more 
like them – are made available only through the 
unique, powerful combination that is EAE on MCP. 
There’s really no reason to look anywhere else.
 
Upgrading but not Moving
That idea goes double when you upgrade to  
Agile Business Suite (AB Suite®).

Making the move to AB Suite enhances and 
extends what you’re doing in EAE today. And 
by keeping the MCP operating environment a 
constant, you’ll be able to appreciate the  
benefits AB Suite delivers much faster than if  
you switched platforms at the same time.

That’s because upgrading to AB Suite on 
MCP enables you to transition over all of your 
applications – as well as the various processes 
behind them – without rebuilding anything. 

While avoiding the associated effort, cost, and risk 
is great in its own right, doing so also means you’ll 
have more time to focus on what Object-Oriented 
programming concepts, the Microsoft® Visual 
Studio® interface, and Microsoft Team Foundation 
Server (TFS) integration can do for your business. 

And you’ll be quicker to market as a result.
But there are even more reasons to stay on the 
MCP environment as you transition to AB Suite.

Embracing a New Era
Running AB Suite on MCP puts you in a prime 
position to capitalize on IT’s new application- 
centric era. 

As applications increasingly become the 
differentiator, companies are less tied to hardware 
than they once were. Instead, they’re prioritizing 
their infrastructures based on what enables these 
assets to deliver the most value to the most 
people in the most places.

And with the ClearPath Software Series and its 
software-only deliverables, we’ve readied the MCP 
environment – and AB Suite – to support and 
enable this application-centric mindset. 

With the entry-level ClearPath MCP Bronze and 
Silver Software Series products, you can run the 
MCP environment on applicable x86 infrastructures 
or VMware® vSphere® and Microsoft Hyper-V® 
hypervisors. You’ll have the freedom to develop 
what you want when you want, regardless of the 
hardware you use to get there.

This way, you can take the applications you  
have running on your ClearPath Forward™ system 
today and seamlessly incorporate them into  
the rest of your infrastructure – whether it’s  
as part of a private cloud, virtual environment,  
or software-defined data center. You’ll transform 
the environment into a fluid software stack – 
containing operating environment, database, 
transaction manager, and application environment 
– without foregoing the proven attributes you’ve 
come to rely on. 

What’s more, you can use ClearPath MCP 
Developer Studio, another Software Series 
product, to empower full teams and individual 
developers to work simultaneously within a 
single system, increasing agility and flexibility 
while shortening the time required to push new 
capabilities into production.  >>
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And as you transition to this application-centric, 
software-only, hybrid-cloud world, you won’t have to 
worry about jeopardizing the safety and integrity of 
your critical applications and data. 

With the Unisys Stealth® security portfolio, you’ll 
be able to micro-segment your network in a 
manner that isolates applications while allowing 
them to freely communicate without exposing the 
data used in those communications. With Stealth, 
you can obscure endpoints from unauthorized 
parties and tighten access control by switching 
your focus from physical devices to user identities. 

When you protect data in motion to this degree, 
you’ll feel confident knowing that you’re providing 
the same isolation you’re accustomed to – without 
restricting your organization’s ability to play an 
integral role in today’s application-centric world.

Why Stay?
Sometimes, there’s value in sticking with what 
you know. And when “what you know” is the MCP 
environment, that value is immense. And it will only 
grow as the environment continues to evolve and 
become even more robust.

No matter if you’re using AB Suite already or 
planning your EAE to AB Suite upgrade, running 
these solutions in the MCP environment gives you 
a wealth of capabilities that simply can’t be rivalled 
by any other platform. 

Whether you need to process a high volume of 
transactions, make your database environment 
more scalable, embrace cloud-centric operations, 
or virtually anything else, it’s all right here. And it’s 
all ready and waiting to help you, your applications, 
and your business do some great things. 
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When writing code, it’s smart to think of yourself as a craftsman. After all, the tools you work with  
play a big part in determining the quality and efficiency of the code you write. So let’s examine a few 
useful tools and see how you can activate and even fine-tune them through the Tools>Options> 
Text Editor dialog.  

Commit Aggressive 
Auto-completion just got faster. Part of Intellisense, 
this option commits the selected suggestion with one 
of the special characters that appear at the end of 
your selection: {}[]().,:=-+*\&<>. This is very handy for 
qualified attributes, arrays, and methods.  

Find All References 
Not new to AB Suite, but recently enhanced to work with members of the framework. For example, 
persistent classes would extensively use the built-in Store() method. Now you can ask where this 
method is used on all instances of this class. For those unfamiliar with this option, it’s part of the  
right-click popup menu and acts on the selected text.  >> 
 

Writing and reading code is part of every Agile Business Suite developer’s job. 
That’s why it’s crucial that you understand how the AB Suite Code Editor can 
help you write that code in the most efficient way possible. In AB Suite 6.1,  
we redesigned the Code Editor and fully integrated it with Visual Studio, 
providing a number of powerful new features.     
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Engineering Corner: Unleashing the  
Power of the AB Suite 6.1 Code Editor  
By Fred Heida, Senior Software Engineer, SME System Modeler, Unisys



Peek to Definition  
Need to take a quick look at another method? By using Peek Definition, located in the context menu, 
you can view and edit the invoked method without navigating away from your current location. It’s a 
concept similar to expanding an Insert statement, but with the added benefit of working with the full 
Code Editor experience. The image below shows the Peek Definition window for the method named 
PopulateScreen(). 

The best part is, you’re not limited to one peek per logic. You can have multiple peeks all active for the 
same logic – and even drill down to peeks within peeks.

Format Document  
Distracted by different coding styles throughout a method 
– be it commands defined in mixed case or a mashup of 
abbreviated and standard naming conventions? Without 
consistency, the logic becomes harder to read and keep  
clear of mistakes.

If this happens, use the Format Document option, one of the 
advanced settings in the Edit menu, to automatically change 
the logic to conform to the Command Style settings. This will 
apply to any new logic, including logic you copy and paste.

Keep Track of the Changes 
Want to see what lines of code you changed since the Code Editor opened? The Code Editor keeps track 
for you: a yellow bar on the left-hand margin shows changes made since the document was opened,  
but not saved. It will turn green after you save your changes.

Task List
It can be convenient to include “ToDos” in your comments – but even easier to forget to come back  
to them. Now you can use the Task List in the View menu to keep track of these coding reminders.  >> 
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Dynamic Validation
Mistakes happen, and catching them early can save time. With Dynamic validation turned on, a red 
squiggle will appear as soon as you make a coding mistake, alerting you to errors in real time. This way, 
you won’t have to wait until validation to discover the error.

If you hover over the squiggle, you’ll see additional information about the error. A light bulb may also 
appear with suggestions on how to fix it. The Editor provides suggestions for undefined variables and 
automatically creates them for you, with the correct type, of course. Alternatively, it shows names that 
are a close match in case of a typo.

Call Hierarchy
The Call Hierarchy view enables you to navigate through your code showing all calls to and from your 
selected method. Similar to the call stack in the Debugger, this is a design-time view of all possible 
execution paths. You can invoke it in the View Call Hierarchy context menu to see the methods that call, 
and are called by, the highlighted method.

Scroll Bar Map Mode
The scroll bar has two modes: The default bar mode, 
which only displays annotation indicators on the scroll 
bar, and map mode. Map mode represents the lines  
of code on the scroll bar, and when you click a location 
on the scroll bar, the cursor moves to that location in  
the code. 

Syntax Coloring
Want to see if a token is an attribute and not a variable, or method and not a profile? With the new 
Code Editor, you can set a different color for every element kind used in the code, including variables, 
attributes, methods, and profiles. This way, you can distinguish between them as you read your code.

The features described in this article are but a small sampling of the many new and exciting capabilities 
in the latest version of the Code Editor. We encourage you to try them all today! And if you have 
questions, suggestions, or comments, please reach out to fred.heida@unisys.com. 

Developing Agility
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With help from some Unisys UK technical 
specialists, we’ve outlined a general approach 
that should help you identify, fix, and avoid these 
issues in your environment:

1. Set a performance target
2. Identify the problem area
3. Analyze the code
4. Implement the code changes
5. Test and repeat  

Set a Performance Target  
This is a critical first step – even though it’s 
often an afterthought, or worse yet, not clearly 
defined. This lack of clarity typically stems from an 
imprecise problem definition, such as “XYZ report 
needs to run faster.” That’s why it’s important to 
request a more clearly defined target, such as 
“XYZ report needs to run against the Month End in 
less than four hours.”

Though it may sound simple, setting a clearly 
defined, measurable goal will make it easier to 
determine when your work is done. 
  
Identify the Problem Area  
With a clearly defined target, the next step is to 
discover the source of the problem. When trying 
to identify a problem’s source, start with some 
simple questions:

• When did this problem start? 
• Has it been getting worse over time, or did it 

start after a particular release or feature was 
introduced?

• Has anything else – IC level, new patch, MCP 
update – changed?

Pausing to consider these questions often gives 
you an idea where to start your investigation.

Assuming the source of the issue isn’t related 
to something like a new piece of code, how do 
we work out what’s causing poor performance? 
You could try to find the answer by adding trace 
or diagnostic code to the LDL+ code. While this 
may help, doing this for a large report or piece of 
the system that includes many methods can be 
difficult and time consuming. 

This is where Unisys can help. Working with clients 
on several recent engagements has allowed us to 
identify some alternative approaches.

In the MCP environment, we’ve developed a 
process that allows you to gather statistics about 
the code execution. You can implement it without 
introducing any LDL+ changes, and easily enable 
and disable it as required. The output shows 
which modules and areas of code are used, as 
well as the frequency of their use.  >> 
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AB Suite Application Performance Tuning 

It’s never good news to hear one of your applications is experiencing a performance 
problem. Though you certainly recognize the importance of fixing it, knowing where to start 
isn’t always easy.
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If you use AB Suite on Microsoft Windows®, and 
therefore utilize Microsoft .NET for the generated 
runtime code, you’ll be able to employ standard 
Microsoft instrumentation capabilities, such as 
the Microsoft .NET profiler. With these capabilities, 
you can see which parts of the compiled code 
have been accessed. Although this will not directly 
relate to objects at the LDL+ level, Unisys has 
developed an approach that allows us to correlate 
the output so you can see which methods, Ispecs, 
and attributes have been accessed.

While each of these approaches are relatively 
simple, the real skill lies in analyzing the results.  
In both cases, we recommend engaging with Unisys 
consultants to take advantage of the knowledge 
we’ve gained from multiple client engagements.

Analyze the Code  
Now that you have some idea of where the 
problem is, the next step is to analyze the code. 
One option is to go into the AB Suite environment 
and look at the code. An experienced developer 
may be able to identify the problem code using  
the information gathered in the previous step. 

However, this is another area where Unisys 
experience may help. Our UK team developed a 
powerful query tool called Model Analysis Tool 
for Research, Investigation, and XREF (MATRIX). 
An enhanced version of the XREF utility, MATRIX 
provides query capabilities beyond those in  
AB Suite Developer. Some key capabilities in  
the current MATRIX 2.0 version include:

• Method logic flow, which allows you to create a 
simplified view of the logic showing just method 
calls, conditional statements, and loops

• Compound searches – and, or, not, starts with, 
does not start with

• Automatic “where type” and “where name” 
inheritance usage displays 

• Find all statements that update or read a 
particular Structure

• Find all attributes that have a particular 
definition

• Find usage of an attribute globally or within  
a method, report, or Ispec

• Export results to tables and CSV files

Implement the Code Changes  
The next step is to implement the required code 
changes. If these changes only affect a few areas, 
this can be done via the normal development 
process. However, if the code changes are much 
wider in nature, then it may be worth enlisting 
Unisys assistance.

The pModel capability in AB Suite lets you extract 
LDL+ logic and definitions in plain text, and can be 
used to automate code changes. This automation 
could be as simple as just renaming a field and 
its references throughout the source. Or, it could 
be more complex – something like including a 
reference to a new method or inserting a new 
piece of LDL+ code into every report. 

As part of a recent client engagement, we 
developed a custom tool to automate changes to 
the pModel export file. While the tool was specific 
to this particular engagement, we could easily 
adapt it to other scenarios.

Test and Repeat   
The final step is to test the changes to confirm the 
performance goal has been reached. If you don’t 
see the desired results, go back to step one and 
look for further areas to improve until you reach 
your goal. 

What’s Next?  
If you’re eager to learn more about anything 
discussed above, we encourage you to engage 
with Unisys for a pilot project. For further 
information, please contact your local Unisys 
representative or reach out to one of this article’s 
contributors directly by emailing:  
gary.j.taylor@unisys.com, andy.wardle@unisys.com, 
or nigel.tunnicliffe@unisys.com.

Special thanks to Unisys UK System Architects 
Gary Taylor, Andy Wardle, and Nigel Tunnicliffe 
for drawing on their many combined years 
of experience with LINC, EAE, AB Suite, and 
associated products to create this article.

http://www.app5.unisys.com/library/gmMail/emails/documents/DA_July_15/engineeringcorner_july_2015.html
mailto:gary.j.taylor%40unisys.com?subject=
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A leading unemployment insurance agency, 
this long-time Unisys client helps residents find 
suitable, sustainable employment, works with 
businesses to recruit qualified candidates, and 
administers unemployment benefits programs. 

An EAE user for many years, the agency faced 
an inflection point back in 2015: with support for 
the existing EAE source control tool ending, the 
company knew it needed to locate a replacement 
fast. The agency found it in Microsoft Team 
Foundation Server, and enlisted Unisys Services 
team to put the new capability in place.

We worked with the client to organize a three-
day onsite EAE Version Control Workshop to 
provide initial training for using TFS in the EAE  
environment, including how to use TFS to  
manage source control.

Then, we showed the client’s developers all the 
ways to use TFS, defined the new processes 
they’ll follow, and outlined the steps needed  
to release changes.

Following the workshop, we provided support 
throughout the implementation, as well as off-site 
consulting services designed to help the agency 
get the most from TFS and EAE. 

Only the Beginning…  
As the agency familiarized itself with everything it 
could do with TFS, it had a bit of a revelation: while 
TFS provided plenty of valuable capabilities for the 
EAE environment, there was even more it could do 
when paired with Agile Business Suite.
 
Because of this, the agency decided the time was 
right to upgrade from EAE to AB Suite – and asked 

our services team to guide them through the 
upgrade process. 

The project started with the EAE to AB Suite 
Assessment service, an engagement that helped 
the company uncover and address any areas 
requiring special attention during the upgrade. 

Following the assessment, our consultants  
worked closely with the agency’s developers to 
make sure they understood the key differences 
between the EAE and AB Suite environments.  
We then organized a four-day onsite AB Suite 
Version Control Workshop that provided initial 
training on AB Suite and TFS.

Last, but certainly not least, came the upgrade 
itself. During the upgrade, we helped the agency’s 
team install, configure, and test the new AB Suite 
software – and verify that the environment met 
the requirements of its new AB Suite solution. 
Onsite mentoring and support, aimed at ensuring 
a smooth transition from implementation to 
production, rounded out the upgrade process.

Completing the move to AB Suite enabled the 
agency to bring rich, new capabilities to market 
with the speed a rapidly changing industry 
demands. And by drawing on the Unisys Services 
team’s extensive expertise, the company was able 
to move to AB Suite in a smooth, efficient manner 
– without overtaxing scarce internal resources.

Need help with an EAE or AB Suite project? Looking 
to plan your EAE to AB Suite upgrade? Contact 
your Unisys sales representative to get started. 
Or, check out the ClearPath Forward Services 
homepage for additional information.

Every now and again, a choice you have to make opens up a whole new world of unseen 
possibilities. That’s precisely the situation one of our clients recently faced.     

EAE, TFS, and AB Suite:  
An Upgrade Success Story

http://www.unisys.com/offerings/technology-products-and-services/clearpath-forward-services
http://www.unisys.com/offerings/technology-products-and-services/clearpath-forward-services
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Info Center

New additions to our libraries of How To documents, white papers, and other useful information include:

•	 How	To: Enable Model Extensions in AB Suite 6.1 (NEW)

•	 How	To: Process XML in AB Suite (NEW)

•	 How	To: Use ATT with Messenger Client (NEW)

•	 How	To: Set NLS_LANG Environment Variable to avoid DBMigrate Oracle Unicode  
Conversion Problems (NEW)

•	 How	To: Use Automation Utility for Ngen.exe (NEW)

•	 How	To: Team Foundation Build DevOps Support for Windows (NEW)

•	 How	To:	Use Registry Keys with Windows Runtime (Updated)

•	 White	Paper: Model Extensions for AB Suite 6.1 (NEW)

•	 White	Paper: Use of AB Suite 5 Windows (.NET) Runtime with Microsoft Windows  
Server 2012 R2 Failover Cluster and SQL Server 2014 (NEW)

We’ve released the Agile Business Suite 4.0 
Discontinuance Announcement and updated 
the “Software Qualification and Support Matrix” 
documents for AB Suite releases 4.0, 5.0,  
and 6.1. 

To view these and other resources, simply 
go to public.support.unisys.com and choose 
“Documentation” in the “Public Information”  
box located on the left-hand side of the screen.  
No special login is needed.

In addition, there are several pieces of thought 
leadership available on the AB Suite homepage:

• AB Suite in the Application Lifecycle
• Agile Development with Agile Business Suite
• Unisys Agile Business Suite: Capitalize on 

Change, Don’t React to It

 

Please be sure to visit the ClearPath Forward 
Client Education homepage to view the AB Suite 
Course Catalog and other helpful education and 
training resources.

To stay up to date on the latest happenings in the 
ClearPath Forward world, please subscribe to the 
ClearPath Forward Connection™ newsletter.

If you’re looking to explore AB Suite on an 
evaluation basis, please download AB Suite 
Express today! This free download includes the  
full AB Suite package – AB Suite Developer and  
AB Suite for Windows Runtime – as well as a 
“getting started” course designed to help you 
begin exploring everything AB Suite has to offer  
in no time.

And to learn about everything the ClearPath 
Forward Services portfolio has to offer, please 
check out our brochure, eBook, and high-level video.
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